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1.0 What's in the Box

QTY PRODUCT DESCRIPTION
Mi-16/Mi-16+/Mi-16#
1 o o multiviewer
APANTALC w16 - ,A
Rack Ears

RJ50 to DB9 adapter
cable for GPI

DB9 Breakout Terminal
Block

4
- RJ45 to DB9 adapter
T ~ cable for RS232 interface
Terminators for passive
loop outs
16 P

Analog audio breakout
cable

North American Power
Cord. Note: Countries
outside of North America
the power cord excluded

Optional Redundant
Power Supply.




2.0 Key Features

There are 5 models in the Mi-16 family:

—  Mi-16 — 16x1 multiivewer, one source per window, no copy and duplicating
sources

—  Mi-16+ - 8x2 multiviewer, one source per window, no copy and duplicating sources

—  Mi-16# - 16x2 multiviewer, sources can be copy and duplicated from any input to
any output

—  Mi-16A — 16x1 multiviewer with discrete audio inputs

—  Mi-16-UHD — 16x1 multiviewer with UHD and FHD outputs

General features for all Mi-16 series

— Low latency — single frame processing delay

— Accepts 16 auto-detect 3G/HD/SD-SDI inputs

— Windows can be sized and moved freely

— Decode up to 16 embedded audio channels per SDI input, up to a total of 128
meters

— Ethernet for configuration and extenernal control

—  Dynamic UMD/labes & Tallies (TSL)

— 20 standalone labels

— 4 customizable logos

— 32 GPIs for tallies, count up/down triggers or alarms

— Digital and Analog clocks can be sync’'d with LTC or NTP

— Borders can be turn on or off

— Safe area markers

— Visual alarm tags for video/audio alarm detection

— Audio monitoring output — stereo, AES, embedded SDI and HDMI

— Optional closed captioning decoding and display

— Optional ATC/VITC decoding and display

— Optional advance video alarm (video frozen and video black)

— Optional redundant power supply

—  3-year limited warranty



Mi-16 specific features

16 passive loop throughs

2 simultaneous and indentical HDMI (with mirror SDI) outputs up to 1080P
Each source can only be assigned to a window once

1 analog and 1 digital clocks

Mi-16+ specific features

16 passive loop throughts

2 independent HDMI (with mirror SDI)outputs, 8 windows on each output up to
1080P

2 analog and 2 digital clocks

Each source can only be assigned to a window only once

Mi-16# specific features

16 passive loop throughs

2 independent HDMI (with mirror SDI) outputs up to T080P

2 analog and 2 digital clocks

Each source can be freely assigned to any window

Each source can be copied up to 16 times as long as they are the same size

Each source can be copied to a different size window, but only up to 16 times
Once a source has been copied to a different size, the total number of sources will
decrease by one.

Mi-16A specific features

8 passive loop throughs

2 simultaneous and indentical HDMI (with mirror SDI) outputs up to 1080P
16 channels of discrete analog or AES audio inputs

Each source can only be assigned to a window once

Mi-16-UHD specific features

2 simultaneous HDMI (with mirror SDI) outputs

2 analog and 2 digital clocks

Each source can be freely assigned to any window

Each source can be copied up to 16 times as long as they are the same size

Each source can be copied to a different size window, but only up to 16 times
Once a source has been copied to a different size, the total number of sources will
decrease by one.



2.1 Specifications

Mi-16 Specifications

Inputs
Connector Type
Total Windows

Aspect Ratios

Serial Digital

Equalization

Return Loss

Embedded Audio

Alarms

Environment

Up to 3G (level A/B)/HD/SD-SDI

BNC IEC, 61169-8 Annex A

16

16:9 for all or 4:3 for Standard definition
SMPTE 424M, 292M, 259M, supports
525i59.94, 626150, 720p50, 720p 59.94,
720p60, 1080i50, 1080i59.94, 1080i60,

1080PsF25, 1080PsF29.97, 1080PsF30,
1080p50, 1080p59.94, 1080p60 Level A/B

120m at 2.97 Gbps, 140m at 1.48 Gbhps,
400m at 270 Mbps with Belden 1694A

> 15db up to 1.485 Gbps
>10db up to 3G
SMPTE-272M-A

No audio, audio high/low, no video, video
format display

Operating temperature: 0 ~ 45 C
Operating humidity: 20 ~ 90% RH
Storage temperature: -20 ~ 60 C

Video Output

Audio Output

Output Resolution

Latency

On Screen Display

SDI Color Encoding

GPI

Serial Port

IP

Supported IP
Protocols

Electrical

EMI/RFI

Size / Weight

2 Identical HDMI and SDI
AA, AES and Embedded stereo audio pair

HDMI: 1920x1080P 50/59.94 Hz
SDI: 1080P/1080i 50/59.94 Hz

1 frame

Borders, Static and Dynamic Labels/UMDs,
Tally LEDs, Alarm Tags, Clocks and Logos

10 bit 4:2:2
32 for tally or AXP (ASCII command)

RS-232. Connector: RJ45, Baud Rate up to
115,200. Supports TSL and AXP protocols

100 Base-T for control and configuration
and TSL, AXP protocol

TSL 3.1 for dynamic tallies and labels,
Optional: Utah and PESA router protocols

20 W, 90 - 250 V 50/60 Hz

Complies with FCC Part 15, Class A, CE,
EU EMC, C-tick

TRU. 446 x 452 x 44 mm (L x W x H)



Mi-16+ Specifications

Mi

Inputs

Connector Type
Total Windows

Aspect Ratios

Serial Digital

Equalization

Return Loss

Embedded Audio

Alarms

Environment

Up to 3G (level A/B)/HD/SD-SDI

BNC IEC, 61169-8 Annex A
4,8,120r 16
16:9 for all or 4:3 for Standard definition

SMPTE 424M, 292M, 259M, supports
525i59.94, 626150, 720p50, 720p 59.94,
720p60, 1080i50, 1080i59.94, 1080i60,
1080PsF25, 1080PsF29.97, 1080PsF30,
1080p50, 1080p59.94, 1080p60 Level
A/B

120m at 2.97 Gbps, 140m at 1.48 Gbps,
400m at 270 Mbps with Belden 1694A

> 15db up to 1.485 Gbps
>10db up to 3G
SMPTE-272M-A

No audio, audio high/low, no video, video
format display

Operating temperature: 0 ~ 45 C
Operating humidity: 20 ~ 90% RH
Storage temperature: -20 ~ 60 C

-16# Specifications

Inputs

Connector Type
Total Windows

Aspect Ratios

Serial Digital

Equalization

Return Loss

Embedded Audio

Alarms

Environment

Up to 3G (level A/B)/HD/SD-SDI

BNC IEC, 61169-8 Annex A
4,8,120r 16
16:9 for all or 4:3 for Standard definition

SMPTE 424M, 292M, 259M, supports
525i59.94, 626150, 720p50, 720p 59.94,
720p60, 1080i50, 1080i59.94, 1080i60,
1080PsF25, 1080PsF29.97, 1080PsF30,
1080p50, 1080p59.94, 1080p60 Level
A/B

120m at 2.97 Gbps, 140m at 1.48 Gbps,
400m at 270 Mbps with Belden 1694A

> 15db up to 1.485 Gbps
>10db up to 3G

SMPTE-272M-A

No audio, audio high/low, no video, video
format display

Operating temperature: 0 ~ 45 C
Operating humidity: 20 ~ 90% RH
Storage temperature: -20 ~ 60 C

Video Output

Audio Output

Output Resolution

Latency

On Screen Display

SDI Color Encoding

GPI

Serial Port

IP

Supported IP
Protocols

Electrical

EMI/RFI

Size / Weight

Video Output

Audio Output

Output Resolution

Latency

On Screen Display

SDI Color Encoding

GPI

Serial Port

IP

Supported IP
Protocols

Electrical

EMI/RFI

Size / Weight

2 independent HDMI and 2 SDI with 8
windows each

AA, AES and Embedded stereo audio pair

HDMI: 1920x1080P 50/59.94 Hz
SDI: 1080P/1080i 50/59.94 Hz

1 frame

Borders, Static and Dynamic Labels/UMDs,
Tally LEDs, Alarm Tags, Clocks and Logos

10 bit 4:2:2
16 for tally or AXP (ASCIl command)

RS-232. Connector: RJ45, Baud Rate up to
115,200. Supports TSL and AXP protocols

100 Base-T for control and configuration
and TSL, AXP protocol

TSL 3.7 for dynamic tallies and labels,
Optional: Utah and PESA router protocols

20 W, 90 - 250 V 50/60 Hz
Complies with FCC Part 15, Class A, CE,
EU EMC, C-tick

TRU. 446 x 452 x 44 mm (L x W x H)

2 independent HDMI and 2 SDI with up to
16 windows each

AA, AES and Embedded stereo audio pair

HDMI: 1920x1080P 50/59.94 Hz
SDI: 1080P/1080i 50/59.94 Hz

1 frame

Borders, Static and Dynamic Labels/UMDs,
Tally LEDs, Alarm Tags, Clocks and Logos

10 bit 4:2:2
16 for tally or AXP (ASCII command)

RS-232. Connector: RJ45, Baud Rate up to
115,200. Supports TSL and AXP protocols

100 Base-T for control and configuration
and TSL, AXP protocol

TSL 3.1 for dynamic tallies and labels,
Optional: Utah and PESA router protocols
20 W, 90 - 250 V 50/60 Hz

Complies with FCC Part 15, Class A, CE,
EU EMC, C-tick

TRU. 446 x 452 x 44 mm (L x W x H)



Mi-16A Specifications

Inputs
Connector Type
Total Windows

Aspect Ratios

Serial Digital

Equalization

Return Loss

Embedded Audio

Alarms

Environment

Up to 3G (level A/B)/HD/SD-SDI

BNC IEC, 61169-8 Annex A

16

16:9 for all or 4:3 for Standard definition
SMPTE 424M, 292M, 259M, supports
525i59.94, 626150, 720p50, 720p 59.94,
720p60, 1080i50, 1080i59.94, 1080i60,

1080PsF25, 1080PsF29.97, 1080PsF30,
1080p50, 1080p59.94, 1080p60 Level A/B

120m at 2.97 Gbps, 140m at 1.48 Gbps,
400m at 270 Mbps with Belden 1694A

> 15db up to 1.485 Gbhps
> 10db up to 3G
SMPTE-272M-A

No audio, audio high/low, no video, video
format display

Operating temperature: 0 ~ 45 C
Operating humidity: 20 ~ 90% RH
Storage temperature: -20 ~ 60 C

Video Output

Audio Output

Output Resolution

Latency

On Screen Display

SDI Color Encoding

GPI

Serial Port

IP

Supported IP
Protocols

Electrical

EMI/RFI

Size / Weight

2 Identical HDMI and SDI
AA, AES and Embedded stereo audio pair

HDMI: 1920x1080P 50/59.94 Hz
SDI: 1080P/1080i 50/59.94 Hz

1 frame

Borders, Static and Dynamic Labels/UMDs,
Tally LEDs, Alarm Tags, Clocks and Logos

10 bit 4:2:2
32 for tally or AXP (ASCII command)

RS-232. Connector: RJ45, Baud Rate up to
115,200. Supports TSL and AXP protocols

100 Base-T for control and configuration
and TSL, AXP protocol

TSL 3.1 for dynamic tallies and labels,
Optional: Utah and PESA router protocols

20 W, 90 - 250 V 50/60 Hz

Complies with FCC Part 15, Class A, CE,
EU EMC, C-tick

TRU. 446 x 452 x 44 mm (L x W x H)



Mi-16-UHD Specifications

Inputs
Connector Type
Total Windows

Aspect Ratios

Serial Digital

Equalization

Return Loss

Embedded Audio

Alarms

Environment

Up to 3G (level A/B)/HD/SD-SDI
BNC IEC, 61169-8 Annex A
4,8,120r16

16:9 for all inputs

SMPTE 424M, 292M, 259M, supports
525i59.94, 626150, 720p50, 720p 59.94,
720p60, 1080i50, 1080i59.94, 1080i60,
1080PsF25, 1080PsF29.97, 1080PsF30,
1080p50, 1080p59.94, 1080p60 Level
A/B

120m at 2.97 Gbps, 140m at 1.48 Gbps,
400m at 270 Mbps with Belden 1694A

> 15db up to 1.485 Gbps
>10db up to 3G
SMPTE-272M-A

No audio, audio high/low, no video, video
format display

Operating temperature: 0 ~ 45 C
Operating humidity: 20 ~ 90% RH
Storage temperature: -20 ~ 60 C

2.2 Rear Views

16 video inputs with 16 passive loop outs

Video Output

Audio Output

Output Resolution

Latency

On Screen Display

SDI Color Encoding

GPI

Serial Port

IP

Supported IP
Protocols

Electrical

Size / Weight

2 x HDMI 2.0, 1 x 12G, 1 x 3G
AA and Embedded stereo audio pair

HDMI: 3840x2160P 50/59.94 Hz
SDI: 1080P/2160P 50/59.94 Hz

1 frame

Borders, Static and Dynamic Labels/UMDs,
Tally LEDs, Alarm Tags, Clocks and Logos

10 bit 4:2:2
16 for tally or AXP (ASCIl command)

RS-232. Connector: RJ45, Baud Rate up to
115,200. Supports TSL and AXP protocols

100 Base-T for control and configuration
and TSL, AXP protocol

TSL 3.1 for dynamic tallies and labels,
Optional: Utah and PESA router protocols

55 W, 90 - 250 V 50/60 Hz

TRU. 446 x 452 x 44 mm (L x W x H)

Figure 1 Mi-16 rear view

16 video inputs with 16 passive loop outs

Figure 2 Mi-16+ rear view



16 video inputs with 16 passive loop outs

Figure 3 Mi-16# rear view

16 video inputs with 8 passive loop outs 16 Channels of AA or AES inputs

Figure 4 Mi-16A rear view

16 video inputs ouT

Figure 5 Mi-16-UHD rear view

2.3 Available Options

Redundant power supply — 12V DC



3.0 Hardware boot up

There is no on/off on the Mi-16, this is due to the UL safety regulation imposed on 1 rack
unit products. To power on the Mi-16, insert power cord directly to the AC power
receptacle, the Mi-16 will boot in approximately 10 seconds. When the HDMI output is
connected to the screen, the following information will display on the lower third of the
display for about 5 seconds (see Fig. 1), then followed by the Apantac logo, then the very
last screen layout prior to powering off the unit.

Loading 0SD data

FPGA _ = wversion: 20180104 6 Mi-16 )
Firmware version: 20180723

IP: 192.168.0.100

Figure 6: FPGA/FW version and IP address of the unit will be displayed for about 5 seconds

4.0 Software

This section will help you get the Mi-16 setup as quickly as possible.

Before you can successfully run the jDirector, you must first run the software installation. The
jDirector software can be downloaded from the Apantac Product Page on the Apantac.com
website.

After completing the Apantac jDirector software installation open the application by using the
shortcut created on the Windows Desktop or from the shortcut in the Windows Start Menu under
the APANTAC folder.

Apantac
jDirector

Figure 7: Double-Click on Apantac jDirector to launch the configuration software.


https://www.apantac.com/products/crescent/Mi-16-Multiviewers

When first launching the jDirector software you will first see the intialization screen.

Connect To Mi-16x...

,’1, Local Area Network

- Online

v| Retrieve

Add / Remove Multiviewer

-

Figure 8: jDirector Initialization screen

To connect to the multiviewer your PC must be connected to the same subnet as the
multiviewer. The IP address(es) is displayed briefly on the monitor attached to the
corresponding output at boot up.

Loading 0SD data
FPGA version: 20180104 Mi-16 )

Firmvare version: 20180723

IP: 192.168.0.100

Figure 9: IP address of the unit will be displayed for 5 seconds on boot up.
The default IP address is 192.168.0.100




To connect to the Mi-16 multiviewer click the Add / Remove Multiviewer button

Connect To Mi-16x...

Q Local Area Network|

Connect

Modify TP Address

Add / Remove Multiviewer

Retrieve

0K

Figure 10: Local Area Network -> Mi-16x IP Address Manager

= Click the Please select one drop down menu and select correct model.

Frame Manager

‘— Please select one ---

OUHD

IP Address

[192.168.0.100

Remove

oK

CANCEL

Figure 11: Add Mi-16




Apantac jDirector X
Select Type

Mi-16 Mi-16+ (PLUS) | Mi-16# (SHARP)

Figure 12: Select your Mi-16 model and then enter the IP address

Note: When selecting Mi-16 even if you select incorrect Mi-16 model, the jDirector will
automatically detect the proper version of hardware you have.

Frame Manager X

G
IP: 192.168.0.100

‘Mi-l&x ‘V‘ Remove
COUHD
Mi-16 |

IP Address

ADD

[192.168.0.100

oK CANCEL

Figure 13: Add Multiviewer

Click the ADD button and the selection will appear in the white box above the dropdown.

After you have completed the above steps, click OK to continue, jDirector will take to the
overview mode of the user interface.



If you have previously connected to a Mi-16 before with the jDirector software, you may see

this dialog when you connect to it again, click on OK to continue.

Connect To ...

9 Q Local Area Metwork
Connect

- ©no. 1, Mi-16% (SHARP)
7 @ Network (P: 192.168.0.100) - OK
[ Board (ver.20180723, fp_ver.20180104 Mi-16) OSD (ver.20130919)

Add / Remove Multiviewer

QK

Figure 14: Connecting to a Mi-16 that displays a previous connection

4.1 Changing the Mi-16 IP Address

When at the “Connect to the Mi-16x..." window when first opening the jDirector software you
should see the current IP address if you have added a unit with the above instructions or have

previousely connected to the Mi-16.

= Left click on the Model line to highlight it. (Line above IP address.)
= Click the Modifiy IP Address button on the right.
= Enterin the desired IP address, Subnet mask and Gateway.
Then confirm the change by clicking the OK button.
» Reboot of the Mi-16 unit is required to make the change active.



Connect To .
s E, Local Area Network
¢ o1, Mi-16% (SHARP Connect
7 R MNetwork (IP: 192.168.0.100) - OK
D Board (ver.20180723 , fp_ver.20180104 Mi-16) OSD (ver.20190919)

Modify IP Address

Add / Remove Multiviewer

Online |~| [¥IRetrieve

oK

Figure 15: Mi-16 change IP Address.

4.2 Configuring of the Mi-16 series

Mi-16
The Mi-16 is the most basic model of the Mi-16 family. There are 16 inputs and one
output. Each source can be only assigned to each window once. Once the jDirector is

connected to the Mi-16, the following editor layout will appear.

Apantac jDirector v2.0

File System Status Help

Frame / Overview Output: 1

LOAD SAVE

no.1:Mi-16 1P:192.168.0.111 <« Overview Outputs

Mi-16 IP:192.168.0.111 - Outputs

=3 System
¢ I no. 1:Mi-16
97 Output Board (A)
= 3 foutput (1]

o~ [ Input Source

Figure 16: Mi-16 Overview Mode
Select the Output tab at the top or double click within the white outline of the Overview
Output and this will take you to jDirector’s editing mode.



Mi-16+

The Mi-16+ is the medium model of the Mi-16 family. There are 16 inputs and two output,
8 windows on each output. Each source can be only assigned to each window once.
Once the jDirector is connected to the Mi-16+, the following editor layout will appear.

Apan:‘ac jDirector v2.0 ’
File System Status Help

| Frame [ Overview Output: 1 Output: 2

LOAD SAVE Update all outptus

@ no.1:Mi-16+ (PLUS) 1P:192.168.0.111 << Overview Outputs

Mi-16+ (PLUS) IP:192.168.0.111 - Outputs

=3 System
¢ I no. 1 :Mi-16+ (PLUS)
9 [ Output Board (A)
o~ (7 Output { 1)
o~ (3 Output { 2}
o= [ Input Source

Figure 17: Mi-16+ Overview Mode

Select the Output tab at the top or double click within the white outline of the Overview
Output and this will take you to jDirector’s editing mode.

Mi-16#

The Mi-16# is the most adavanced model of the Mi-16 family. There are 16 inputs and
two output, each output can have up to 16 windows. Each source can be copied to
multiple windows of the same size or different sizes. Once the jDirector is connected to
the Mi-16%#, the following editor layout will appear

Note: Inthe Mi-16#, there are 16 windows resources, when a source is copied to a
same size window, it will not consume any additional window resources, however, when
a source is copied to a different size window than its original size, it will consume one
additional window resource. For example, if source one is copied to a different size
window, then there are only 14 window resources left instead of 15.



[ ] [ ] Apantac Director v2.0
File System Status Help

Frame [ Overview OQutput: 1 Qutput: 2
LOAD SAVE Update all outptus
o) no.1:Mi-16# (SHARP) 1P:192.166.0.111 << Overview Outputs
Mi-16# (SHARP) IP:192.168.0.111 - Qutputs
=3 System

¢ Cdno. 1 :Mi-16# (SHARP)
9 [ Output Board (A)
o= [ Output (1)
o~ [JOutput (2 )
o 3 Input Source

Ready...

Figure 18: Mi-16# Overview Mode

Select the Output tab at the top or double click within the white outline of the Overview
Output and this will take you to jDirector’s editing mode.



5.0 Common features and configurations

5.1 Editing mode

Tool Bar
* Work Space T — ‘e . ) - | Apantac jOirector v2.0 -
* Window Bin. . "o e J
- ObjectBin . |
\ =N | 0 ) upame Q z00mmn

Figure 19: Mi-16 editing mode
Output 1 Qutput 2 Tool Bar
+ Work Space - s = ==
« Window Bin .~ " e

« QObject Bin_

— Mi-16+ Output 1

i

Figure 20: Mi-16+ and Mi-16# editing mode



The jDirector editor consists of 4 major work areas,

Tool Bar, is where all the tool short cuts reside

Work Space is the space to edit the on screen layout and look

Window Bin, where all the windows templates reside

Object Bin, where all the objects such as standalone labels, digital clocks, analog
clocks and temperature alarm

CJ Update

5. button on the tool bar will update the laytout on the PC to the
Mi-16 output.

> wnn -

5.2 System level settings
5.2.1 Set output timing

The Mi-16 series comes with the default output setting of T080P60Hz, it can easily be
changed to 1080P50Hz by doing the following,

O n the Top Level M en U, Tmo — |v‘ ‘ - Outpu‘t'M‘a‘nag; ‘
C||Ck on SyStem -> ELocalArea‘Network !
e o
O ut p ut M a n a g er to Set D Output 2: (Display: 2) - 1920 x 1080 (60Hz)
the output timing.
[ JoN ]
File |System | Status Help

Input Source Manager...
F T

= | Output Manager...
L 7 Output Manag

Tally colors
KA System Setting...
Reference audio level choice...
ﬁ Reset All Frame Outputs... I

Figure 21: Output Manager



5.2.2 Sources, Names, Tally and Other Setups

Every Mi-16's source attributes can be configured in a single place. Since the Mi-16#
allows copying of the sources, these attributes can follow the sources every time it is
assigned to a new window.

These attributes are as follows:

Names
» The default names are Input (1) to Input (16), each name can have up to 32
characters

= The names can be static or dynamic. When the names are set to dynamic, the
UMD of the window will become blank and waiting for the name assignment to
come from an external tally management system such as TSL or TSI.

TSL
In order for the names to be dynamic, the TSL address is assigned to each source.
The default assignmentis 0 ~ 16

Tally Mode
The Tally can be either trigger via GPI or an external tally management system such
as TSL or TSI.

Tally attributes
Whether the tally trigger is GPI or TSL, the tally indicators can be assigned to on

screen elements such as LEDs, borders, UMD text and UMD text colors.

To start configuring the Input Source table



On the top

menu, go to
System -> Input
Source

Manager, the
Input Source
Manager dialog

will pop up.

e0e®
File

System| Tools Status Help

Fl
TI

Input Source Manager...
Qutput Manager...
Tally colors

System Setting...

Reset All Frame Outputs...

Input Scurce Manager

Mi-16 1P:192.168.1.151

Input Name Fixed /Dynamic TSL address Tally Mode Tally
1 Input (1) Fixed a GPI Configure
2 Input (2} Fixed 0 GP1 Confiqure
3 Input (3 ) Fixed 0 GPI Configure
4 Input (4} Fixed 1] GP1 Configure
S Input (5 ) Fixed a GPI Configure
6 Input (6 ) Fixed 0 GP1 Configure
7 Input (7 ) Erend,, anallin e GPI Configure
8 Input (8) Apanta GPI Configure
9 Input (9) | Input Source Name I GP1 Configure
10 lnDutg 10 ; [Cameray |} GPI Configure
11 Input (11 1 GPI Confiqure
12 Input (12) Ok { Cancel \ [ GP1 Confiqure
13 Input (13) e = GP1 Confiqure
14 Input ( 14 ) Fixed [i] GP1 Configure
15 Input (15) Fixed 0 GP1 Configure
16 Input (16 ) Fixed 1] GP1 Configure

Quick Settings
default

None =] [ s | - —

Figure 22: Input source manager

Name the source

Click on any of
the Name field
and start
assigning
names. Click
<OK>, then it will
automatically
jump to the next
name until you

Apantac

Input Source Name

Input Source Name

Apantac

|Camera 1]

| input (1.2 )

| 0K || Cancel‘

| 0K HCancel‘

Figure 23: Enter source names

hit <Cancel>
Continue to name all the sources. . iout Source Nanager
Mi-16 1P:192.168.1.151

Input Name Fixed /Dynamic TSL address Tally Mode Tally
1 Camera 1 Fixi 0 GPI Configure
2 Camera 2 Fixed 0 GPL Configure
3 Camera 3 Fixed 0 GPL Configure
4 Camera 4 Fixed 0 GP! Configure
5 ut (5) Fixed 0 Gl Confiqure
6 Input (6) Fixed 0 GP! Configure
7 Input (7) Fixed 0 Gl Configure
8 Input(8) Fixed 0 GP! Configure
9 Input (9) Fixed 0 GP! Configure
10 Input (10} Fix 0 GP Configure
11 Input ( 11 ) Fixed 0 GP! Configure
12 Input (12 ) Fixed 0 GP Configure
3 Input (13 ) Fixed 0 GP! Configure
4 Input (14 ) Fixed 0 GP Configure
Input (15) Fixed 0 GP! Configure
6 Input (16 ) Fixed 0 Gl Configure

Quick Settings
] L] —
Figure 25: Input source manager with updated names




Quick Settings

There are
several quick
settings that will
speed up the
setup process

L]
Mi-16 IP:192.168.1.151

Input Name Fixed | Dynamic T
1 Input (1) Fixed
2 Input(2) Fixed
3 Input(3) Fixed
4 Input(4) Fixed
5 Input (5) Fixed
6 Input (6 ) Fixed
7 Input (7)) Fixed
8 Input (8 ) Fixed
9 Input (9) Fixed
10 Input (10) Fixed
11 Input (11) Fixed
12 Input (12) Fixed
13 Input (13) Fixed
14 Input (14 ) Fixed
15 Input (15) Fixed
16 Input (16 ) Fixed

Quick Settings
default

Reset Input Names
Clear all source Tally GPI bit

Tally - 1 GPI bit per source
Tally - 2 GPI bit per source

Figure 25: Quick Settings




Set all attributes

Confirmation

to defal‘”t default | |z| Set all items to default, continue? |
Figure 26: Click on <Yes> to return to default
Rest |npUt Input Name
1 Input (1)
Names <SET> - 2 Input ( 2 )
' 3 Input (3)
will set all the 4 Input (4 )
. 5 Input (5}
Input names None — 6 Input (6)
7 Input (7 )
back to Input (1), | [vene B 8 Input (8 )
Reset Input Names 9 Input (9 )
Input (2) and SO | |qiear all source Tally Gpr bit ﬂ %”F‘UEE ﬂi
on Tally = 1 GPI bit per source = 12 [:Eﬂt (12)
Tally = 2 GPI bit per source 13 Input ( 13 }
All Input Names TSL | 9 14 Input ( 14 )
All Input Mames static | 15 Input ( 15)
Reset TSL Addresses Ad 16 Input (16 )

Figure 27: Reset Input names

Figure 28: Names reset to default

Clear all source

[ NeN ] Set GPI Tally Attributes
Ta”y GP' b|t Window Object Tally
. GPI Contact
<SET> — will None - e e I I
| “ ” N LED1: Oz Oz
clear all GPI ta one = : .
y Reset Input Names (EEZEN s B O ‘
settings Clear all source Tally GPI bit Border:  []! 02
Tally - 1 GPI bit per source = UMD Text:  []1 Oz
Tally - 2 GPI bit per source UMD Bkg:  []1 Oz
All Input Names TSL 1 4
R -
Figure 29: Clear all source GPI bits  Figure 30: GPI bits reset to default
) [ JoN ] Set GPI Tally Attributes
Tally - 1 GPI bit per source - oG e
None = GPI Contact [rere]~]
Reset Input Names LEDL: 1 mH]
(Clear all source Tally GPI bit LED2: 1 Oz
Tﬂly -1 GPI bit per source = Border: []1 Oz
Tally - 2 GPI bit per source UMD Text:  []1 D%
Al Input Names TSL |4 GDEm TR Ok
All Input Names static
Reset TSL Addresses =

Figure 31: Set 1 GPI bit per source

Figure 32: Only 1 bit is set on GPI Tally




Tally — 2 GPI bit
per source
<SET> - will
sequentially
assign two GPI
tally per source

. [ JoN ] Set GPI Tally Attributes

Tally - 1 GPI bit per source - ) ,
Window Object Tally

None |~ GPI Contact -]
Reset Input Names T T TR P
Clear all source Tally GPI bit Lep2: [ vz
Tally - 1 GPI bit per source = Border:  []1 Oz
Tally - 2 GPI bit per source UMD Text:  []1 [J2
All Input Names TSL | 8 umDBkg:  [11 - L]2
All Input Names static
Reset TSL Addresses ~|

Figure 33: Set 2 GPI bits per source  Figure 34: both bits are set on GPI Tally

All Input Names
TSL <SET> will
change all
Fixed/Dyanmic
Names from
“Fixed” to
“Dynamic”

. d

Tally - 2 GPI bit per source - TN e
nput (2 ) Dynamic
nput (3 ) Dynamic
higne: I t N = nput (4) Dynamic
Reset Input Mames nput (5) Dynarnic
P . Input (6) Dynamic
Clear all source Tally GPI bits Tnput ( 7) Dynamic
Tally - 1 GP1 bit per source = L b
= i Input (10 ) Dynamic
LE;”I‘:I im EF;:_SDUI‘CE Input (11) Dynamic
Input (12 ) Dynamic
i . | Input (13 ) Dynamic
All Input Names static n PDUEE i?% &"am?c
npu namic
Reset TSL Addresses - Tnput { 16) BT

Figure 35: Set all Input Names to TSL  Figure 36: All input names set to Dynamic

All Input Names | |all input Names static - . FuedDyanc
. . Input (2 ) Fixed
static <SET> will | [uone = Tout 03] Fied
. Reset Input Names %nnui%g; E@x:g
change all Fixed | |ciear ail source Tally GPI bits Tnput (7), Fved
/ Dyanmic Tally - 1 GPI bit per source = T Fed
y Tally - 2 GPI bit per source Ihput (10} ixed
nput {11) Fixed
Names from All Tnput Names TSL L Input (12) Fise
npu X4
u . All Input Names static | %nguvt: E i;% =
Dynamic” to Reset TSL Addresses i Input (16 Fml
“Fixed” Figure 37: Set all Input names to static  Figure 38: All input names to Fixed
Reset TSL Al Il'lput S - Fixer:::‘)lcjev;amic TSL agdress
Fixed 1
Addresses None = Feed :
. Reset Input Names Fixed 4
Fixed o]
<SET> will set all | |qear ail source Tally GP1 bits Fied 8
TSL address Tally - 1 GPI bit per source = Foeed z
a
Tally - 2 GPI bit per source e 0
back to default O | [All Input Names TSL L Ficed u
All Input Names static | Fixed 13
~ 15 Reset TSL Addresses = Fred s

Figure 39: Reset all TSL Addresses Figure 40: All TSL addresses set to default




Change Name Fixed / Dynamic

. Fixed -
from Fixed to e ed
Dynamic and Dynamic
vise versa Figure 41: Change UMD from Fixed to Dynamic
Change TSL -
addressesk. | Input Address

‘ | o

Double Click on
the TSL address -

Cell and change
it to the desired
number between
0to 127

Figure 42: Input TSL address

Set TSL Tally
attributes. Set
Tally mode to
TSL, double click
on Tally ->
Configure

| @ Set TSL Tally Attributes

Window Object Tally
| TSL Address

[ Tally Level 1

| 0 LED1: Wi 2 O3 4
LED2: 01 2 O3 4

Border: [J1 [J2 [J3 [J4

UMD Text: []1 [J2 [13 [4

UMD Bkg: [J1 [J2 [J3 [4

Figure 43: Set TSL tally attributes

Change the Tally

Tally Mode

Mode between GPI B
GPI to Tally GPI

TSL

Figure 44: Change Tally Mode to GPI
Set GP| Ta”y o0 ® Set GP Tally Attributes

. | Window Object Tally
attributes. Set I
Tally mode to ot @1 02
. LEDZ2: O ]2

GPI, double click S
on Ta”y -> : UMD Text:  []1 P

| UMD Bkg:  []1 (mp]
Configure ‘

|

Figure 45: Set GPI tally attributes




5.2.3 Set Tally colors

Set Tally Colors.
System -> Set Tally
colors

System | Tcols Status Help

Input Source Manager...
?:; Output Manager...

Tally colors
System Setting

Reference audio level choice...

Reset All Frame Qutputs...

‘® Frame GPI Tally Settings
Tally Color
Tally 1 Tally 2 Tally 3 Tally 4
. I .
Com ] [ow] [wm] [ o]

Figure 46: Configure Tally colors

Figure 47: Set Tally Colors

5.2.4 System Settings

Set system settings.
System -> System
Settings RS-232
Communication
mode can be set for
software control or
TSL. Temperature
alarm setting as
well as current
temperature will
also be shown in
this dialog

- ®
System | Tools Status Help

[ Frame System Settings

R5-232 port

Mode 1: Software Control

-

Mode 1: Software Control
Mode 2: TSL 3.1

Frame Alarm

Temperature Alarm

Temperature High Thresheld (*C): [s0
Temperature Low Threshold (°C): |0

Now Temperature: 31.c

Input Source Manager...

; E:. Output Manager...

Tally colors

@ System Setting...

Reference audio level choice...

Reset All Frame Outputs...

Figure 46: System Settings

Cance

Figure 47: Set to AXP or TSL




5.2.5 Audio reference settings

Reference aUdIO [ [ ] Global Reference audio level choice...
setting can be set Pon
[ | Dig Ref Level
BN ) 6 dBFS -
System| Tools Status Help 10dBFS |4
Input Source Manager e B
: | 6 dBFS
FE:; Cutput Manager... 4 dBFS
' 2 dBFS 3
Tally colors 0 dBFS
EA System Setting... -2 dBFS ||
-4 dBFS -
Reference audio level choice... =
[ ok | | CANCEL
Reset All Frame Outputs...
Figure 48: Audio reference Figure 49: Set dBFS

5.2.6 Load/Save presets

The Mi-16 series can have up to 30 presets. Each Mi-16x comes with 10 preloaded
presets. Please see Appendix A for all the preset layouts.

Load Presets by File ->
Glogal -> LOAD

| JON |
File| System Tools Status Help
Global ¥ SAVE

ut: 1

Write to flash... | LOAD

-{llExit [ | 9 |:

Mi-16
IP: 192.168.1.151

Figure 50: File -> Global -> LOAD

Highlight the preset you
want to load, then click on
<LOAD>

[ ] Global Preset
no.1: Preset01.0Px [=3 Frame Preset Information
no.2: Preset02.0Px o [Jnol. 192.168.1.151 (Mi-16+ (PLUS) )

no.3: Preset03.0Px
no.4: Preset04.0Px
no.5: Preset05.0Px
no.6: Preset06.0Px
no.7: Preset07.0OPx

no.10: Preset10.0Px

File Name: | | .oPx

Delete file

Clear all preset files

Figure 51: File -> Global -> LOAD




You can also load preset
from the overview mode.
Highlight the preset you
want to load then clock on
<LOAD>

e0ce
File System Tools Status Help

Frame [ Overview r Output: 1 |

| [oay |[ save | [ uodateal outotus

D no.1:Mi-16 1P:192.168.1.151 <<

=1 System
¢ CJno. 1 :Mi-16
¢ =] Output Board (A)
o= J0utput { 1)
o= 3 Input Source

Figure 52: Load from Overview mode

Overview Out

Save Presets by File ->
Global -> SAVE

L JoN
Fle| System Tools Workspace Status
Global »| SAVE
Restore presets to frame ... | LOAD
Copy layout to all models...
Write to flash... |:

[ exit e

Figure 53: File -> Global -> SAVE

[ ] Global Preset

=3 Frame Preset Information
[ not. 192.168.0.100 (UE-8 (A))
[ no2. 192.168.0.101 (UE-8 (B))

4] Il [ I»
< Il D
File Name: [Preset_0g| | .opx
Delete file SAVE
Clear all preset files Cancel

Figure 54: File -> Global -> SAVE




6.0 Editing
6.1 To delete a window

There are two methods to remove a window.

1. Highlight the window you would like to delete
a. Press the <delete> key

ik 3dis [T s [T

window 1 window 2 window 3 window 4
input no: 1 input no: 2 input no: 3 input no: ¢
Input (1) Input (2] Input [ 3) Input (4]

[ s [ s
window 7 window 8
input no: 3 input no: 6 input no: 7 input no: 8

window 5 window &

Input (5] Input (6] Input [ 7) Input [ 8)

[ [ [ [

window 9 window 10 window 11
input no: 9 input no: 10 input no: 11 input no: 12
Input [ 9) Input [ 10) Input ( 11) Input [ 12)

window 12

R R [ram——

window 13 window 14 window 13
input no: 13 input no: 14 inpul no: 15
Input [ 13) Input [ 14) Input [ 15)

window 16
input no: 16
Input( 16)

Tnput( 16 )

Figure 55: Click on the window you want to delete to highlight it, then press the <delete> key on the keyboard.

b. Orright click on the window and select <Close>

[

window 4
input no: 4
Input (4]

Properties

Set Objects...
[r— Set Border...
window 8 Set Audio...
input no: 8
Input (8) Set Safe Area...

Select Input Source ...
¥ Lock Object Items
Input( 8} Jec

— Return Objects to Default Position

indow 12
input nor 12 [

Input [ 12

Close

Figure 56: Right click on the window you want to delete to highlight it, then select <Close> to close the window



s s [ [
window 1
input no: 1

Input (1)

window 2
input no: 2
Input (2]

window 3
input no: 3
Input ( 3)

window 4
input no: 4
Input { 4)

s s s s

window 5
input no: 5
Input (5)

window &
input no: 6
Input (6]

window 7
input no: 7
Input({ 7]

window 8
input no: 8
Input( 8]

s s [ [
window 9
input no: 9

Input (9)

window 10
input no: 10
Input ( 10)

window 11
input no: 11
Input(11)

window 12
input no: 12
Input( 12)

s hia s [
window 13
input no: 13

Input ( 13)

window 14
input no: 14
Input ( 14)

window 15
input no: 15
Input ( 15)

Figure 57: The end result

How to delete multiple windows
1. Press and hold the <CTRL> Key
2. Highlight the windows you would like to delete
a. Press the <delete> key

i didis i didis i didis i didis

window 3 window 4
input no: 3 input no: 4
Input (3] Input (4]

window 1 window 2
input no: 1 input no: 2
Input (1) Input (2]

Vi didis Vi didis Vi didis Vi didis

window 7 window 8
input no: 7 input no: 8
Input (7] Input (8]

window 5 window 6
input no: 5 input no: &
Input (5] Input (6]

Vi ihis s

window 9 window 10
input no: 9 input no: 10
Input (9] Input ( 10)

window 11 dow 12
input no: 11 = input no: 12
Input ([ 11) = Input ([ 12)

s s

window 13 window 14
input no: 13 input no: 14
Input ( 13) Input ( 14)

i idis E u s
window 15 o window 16
input no: 15 = input no: 16
Input [ 15) = Input [ 16)

Figure 58: Hold down the CTRL key and click on multiple windows, then press the <delete> key on the

keyboard
b. Orright click on the window and select <Close>

Align ’
Auto Arrange
Fit Windows Group Area

grase |
Copy Windows

i Close




Figure 59: Hold down the CTRL key and click on multiple windows, then right click on a highlighted window,

then select <Close>

[rE

window 1
input no: 1
Input (1)

[

window 5
input no: 5
Input [ 5)

[

window 9
input no: 9
Input (9]

[

window 11
input no: 13
Input ( 13)

Figure 60: The end result

[
window 2
input no: 2
Input [ 2)

i

window 6
input no: &
Input [ 6)

[
window 10
input no: 10
Input ([ 10)

[
window 12
input no: 14
Input [ 14)

s

window 3
input no: 3
Input [ 3)

i

window 7
input no: 7
Input ([ 7)

[
window 4
input no: 4
Input [ 4)

i
window 8
input no: 8
Input [ 8)

6.2 Mi-16 series window styles

o The Mi-16 series comes with 5 basic window styles. These styles are located in
the “Window Bin" area of the jDirector editor.

o Each window style consists of 4 window templates

o Each window has 4 predefined sizes — 1/4,1/9,1/16, 1/25

=

" style 3 ” |1 Style 4 u

b [T

Style 5
]

Figure 61: Highlight the preset you want to load.  Click on <LOAD>

Style 1 templates — windows with 2 tally LEDs

xd' il
S Sl
Label

Window Templates

CLOSE




Figure 62: Highlight the preset you want to load.  Click on <LOAD>

Style 2 templates — windows with no tally LEDs

[ ] Window Templates

1
LEJ Labe Lobe

CLOSE

Figure 63: Highlight the preset you want to load.  Click on <LOAD>

Style 3 templates — windows with skin labels and 2 tally LEDs

‘ @ Window Templates

Label Label

L TWE

CLOSE

Figure 64: Highlight the preset you want to load.  Click on <LOAD>

Style 4 templates — windows with skin labels and no tally LEDs

@ Window Templates

Surdie Sl

CLOSE

Figure 65: Highlight the preset you want to load.  Click on <LOAD>




Style 5 templates — windows with labels and tally LEDs over the video

® Window Templates

CLOSE

Figure 66: Highlight the preset you want to load.  Click on <LOAD>

6.3 How to insert a window

1. Click on a window style

..............

3. Select the window size - 4, Place the window

Figure 67: Highlight the preset you want to load.  Click on <LOAD>



6.4 Customize Window Elements

In addition
H Properties
to window .
templates, Set Border...
Select Input Source ...
each Set Audio...
. Set Safe Area...

Wi ndOW ™ Lock Object Items
elemen‘ts Return Objects to Default Position

. Copy
can still be
customized Close
by right Figure 68: Right click on a window
clicking on
the window
Set Window - s

. Properties
ObJeCtS Set Objects... Tally Alarms
Set Border... LED 1 [] video Format
Ta”y LEDS: Select Input Source .. [¥lLED 2 [ Audio Status
Set Audio...
On/off Set Safe Area... et
. ™ Lock Object Ttems [Jomp

Borders: Return Objects to Default Position bl UMD
On/off, Copy
width and Close
skin Figure 69: Select <Set Object> Figure 70: Check the objects to turn on/off
OMD/UMD: ]
On/off
Alarm tags:
Video
format,

Video frozen

Figure 71: Alarm tags turned on

Set Borders:
» Size 0
to 7/
pixels
» Size 0

borde
r off
= Colors

Properties

Set Objects...

Set Border...
Select Input Source ...
Set Audio...
Set Safe Area...
¥ Lock Object Items

Return Objects to Default Position

Copy

Close

Figure 72: Select <Set Border>

oK Cancal

Figure73: Set Window border




Set Window Border

Size: 2 - Color.

OK

Figure 74: Alarm tags turned

-

Cancel

Figure 75: Alarm tags turned on

Set Border
Skins:

There are 6
predefined
skins, if you
would like to
make your
own skins,
please
contact
Apantac
tech support
for futher
assistance

Figure 76: Choose Skin Border

Figure 77: Skin 1

)

Figure 79: Skin 3

Figure 78: Skin 2

Figure 80: Skin 4

Figure 81: Skin 5

Figure 82: Skin 6




Select Input
Source.
Note:
Mi-16#
allows you
to freely
assign
sourcesto a

Only

window.
Mi-16 and
Mi-16+ the
sources are
preassigned

Properties

Set Objects...
Set Border...

¥

Select Input Source ..
Set Audio...

Set Safe Area...

Lock Object Items

Return Objects to Default Position

Copy

Close

Figure 83: Select Input source

6: Input (6 ) -

Figure 84: The available sources

and cannot
be copied
Adding /
removing
au d |O Propetties
Set Objects...
meters to Set Border...
Select Input Source ...
Wlndows by Set Audio...
Set Safe Area...
H H H ¥l Lock Object Items
rlght CIICklng Return Objects to Default Position
on a window Copy
and select Close
<Set Audio> | Figure 85: Select Audio
Once a M
source is Freview
assigned to
a window,
you can now
make aUdiO Total Meters: |4 -
. 9 -
ass|gnmen‘[s Meter 1: SDL: 9, o
— = Meter 2: SDI: 9, 1
. Meter 3: SDI: 9,
to the = — | : = Meter 4: SDI: 9, ii
meters. — 5 ! . i: =
YOU can — o ‘ Audio Source 118 =
assign up to | Figure 86: Alarm tags turn Figure 87: Alarm tags turn
16 channels
of audio to a
single

window




Set Safe
[ XK ) Safe Area Config
Area (SafeAreal] SafeAreaz |
Each Properties ClEess “‘T“T“’C il y
4 p| 50%

window can Set Objects...
h Set Border... e N::::;”gi Ratio Fix

ave up to2 Select Input Source ...
safe areas. Set Audio...

Set Safe Area...
To setand ¥ Lock Object Ttems e 0%
enable the Return Objects to Default Position
safe area, Copy
right click on a
ose -DK -EANE

a window
and selec Figure 88: Enable first safe area Figure 89: Enable first safe area
<Set Safe
Area>
There are two tabs, sce Safe Area Gonig
" n afe Area afe Area

Safe Area 1" and R —

Enable Reduce Y/C
“Safe Area 2". I Il b so
-Line Color
CheCk the ”Enable" Safe Area Adjustments
box On “Safe Area 1"’ Percentage: Ratio Fix
[«]]l] || 100% | 4:3 H 16:9 H 14:9 |

then use the

Percentage slider to -
move the safe area to
5% on each side.

5%

Tl

5%
[1»]
—
-| 5%
——

o

5%

Figure 90: Set percentage

CANC




Click on “Safe Area 2"
tab. Check the
“Enable” box, then,
select Ratio Fix <4:3>,
the click OK to exit

e e
Safe Area 1 | Safe Area 2

Safe Area Config

Enable

Safe Area Adjustments

Percentage:

Ratio Fix

Il

M 100%

12%

‘ 4:3 || 16:9 || 14:9 |

[l T»]

[«
= =
I-I U%

L]

[« Ti]

12%

Figure 91: Enable second safe area and enable 4x3 safe area

Click on “Safe Area 2"
tab. Check the
‘Enable” box, then,
select Ratio Fix <4:3>,
the click OK to exit

[ JeN ] Safe Area Config
Safe Area 1 | Safe Area 2
Enable
Safe Area Adjustments
Percentage: Ratio Fix
|1‘|||| [p 100% | a:3 || 16:9 H 14:9 |

12%

[n]_Tv]

[«
- =
I-I D%
=

-

[ Tu]

[»

12%

Figure 92: Enable second safe area and enable 4x3 safe area




You can now see the
the safe areas
enabled on the
window

not assigned

Figure 93: After safe area was turned on

Unlocking objects —

Properties

the objects in the

. Set Objects...
windows cannot be Set Border...
e . Select II'I|JLIt Source ...
moved until it is B

Set Safe Area...
¥ Lock Object Items

Return Objects to Default Position
Copy

unlocked

Close

Figure 94: Unlock objects

Return objects to

default position —

Properties
Set Objects...

Set Border...

Select Input Source ...
Set Audio...

Set Safe Area...

Lock Object Items l

Return Objects to Default Position
Copy

returns all objects to
the position prior to
their move

Close

Figure 95: Return all objects to default position

Copy/Paste —
Windows can be
copied and pasted

Properties
Set Objects...

Set Border...

Select Input Source ...
Set Audio...

Set Safe Area... J
Lock Object Items

Return Objects to Default Position

Copy
Paste

Close




Figure 96: Copy — (Also, CTRL C)

Setup standalone
label

ace Apantac jDirector v2.0
File System Status Help
[ Frame / Overview | Output: 1
Taols
o= 12 () update Q zoomiIn

not assigned

1 B0 . 866, 496,37

Figure 97: Drag label from object bin to workspace

Insert Digital Clock.
Drag “Digital Clock”
into the work space

[ ] [ ] Apantac jDirector v2.0
File System Status Help

Frame / Overview | Output: 1
Tools

™ | 22 () undate | Q zoom in |

not assigned

Temperature ( 2)

[ i Ol

Figure 98: Drag the digital clock onto the workspace

Right click on the
label to bring up the
properties dialog.
Uncheck “Enable
DATE", “Enable YEAR”,
remove “Clock from
the Name field and
select the time zone

Properties
Control...

Close

e e Set Clock Properties...
Preview Option
[] Enable AM/PM
[ Enable YEAR
[] Enable DATE
[] Enable Day Of Week
Enable Second

Font Size Name Font Color  Background Co... [ Enable AM PM TN FRONT
’7 FAFAFA 646464
Font 3 é
ETEm™ - T
Mode Time Sync. By.
@® Clock
O Count [mtemal—+] Sync. PC GMT Time
o Time ot
[] Daylight saving
‘[GMT-OE:O\J) Pacific Time (US & Canada) v‘ GMP + [-26800 | Seconds
(GMT-08:00) Pacific Time (US & Canada) |
(GMT-08:00) Tijuana, Baja Califomnia =
(GNT-07:00) Arizona
)

(GMT-07:00) Mountain Time (US & Canada)
(GMT-06:00) Central America

|(GMT-06:00) Central Time (US & Canada)
(GMT-06:00) Mexico City

“L(GMT-06:00) Saskatchewan ~




Figure 99: Edit digital clock properties  Figure 100: Set time zone

Set font color to
White, click <OK> and
set background color
to black, then click
<OK>

eCe Choose Font Color
Swatches | HSV | HSL | RGB | CMYK

Preview

D Sample Text Sample Text

Figure 107: Edit font color

e e
Swatches | HSV | HSL

Choose Background Color
RGE | CMYK

Preview
o - W Sample Text Sample Text .
. L . Sample Text Sample Text

Figure 102: Edit background color

Right click on the label
to bring up the
properties dialog.
Select Font 4 for the
largest size font.

e o Set Labal Properties

Mode Font Type
& ETF ASCHI F Font 2 —

Unicode Font 1

Font 2

Font 3

ont 4

TEXT Preview

Label

.;{el\c - [ | )
Set Label Properties...
Close

ok 1T 0K CANCEL

Figure 103: Set label properties Figure 104: Set label properties

Set font color to White,
click <OK> and set
background color to
black, then click <OK>

ece Choose Font Golor

(‘Swatches | HSV_| HSL | RGB | cmYK

ece Choose Background Color

Swatches | HSV | HSL | RGB | CMYK

Preview Preview

m] sample Text Sample Text

Figure 105: Set font color

-] - l Sample Text Sample Text .
. L} . Sample Text Sample Text
Figure 106: Set background color




Set Label Font Type.
Set Label Mode:

Follow Source or Static.
When set to <Follow
Source>, the label name
will follow the name
assigned in the Input
Source Manager.

When set to <Static>,
the label name can be
renamed to names such

]
Mode

®) ETF ASCII Font

TEXT Preview

Set Label Properties

Font Type Mode
Font 3 - @ ETF ASCII Font.
Font 1
Font 2
Font 3

TEXT Preview

not assigned

Set Label Properties

Font Type

Crm—

Font Color Background Co... | Skin Font Color Background Co...  Skin
| [] Enable || [l Enable
[ st ] [ st ] I 1| [ st ] [
Mode Name Mode Name
Follow Source | v Follow Source |~
Follow Source
|Static
Transparency bl

ETT T a—

o]

CANCEL

100.00 % -

CANCEL

as “Program” and Figure 107: Set Font Size Figure 108: Static or follow source
“Preview”
To insert digital clock by | «.. ‘ e
draggin the <Digital
99 9 ) € tpane Q zoom

Clock> to the work
space

0

==

not assigned

Figure 109: Drag digital clock from object bin to workspace

Right Click on the digital
clock in the the
workspace, this
configuration dialog will
appear

Preview

Font Size

Fos T+]

Mode
® Clock
© Count

Time Zone

[] Daylight saving

Name

Portland| |

Set Clock Properties...

Font Color

Time Sync. By.

SR

|
SET SET

Time Offset

|(GMT) Greenwich Mean Time : Dublin, Edmhum‘v|

Figure 110: Configure clock

Background Col...

GMP + |0 Seconds

Option
[] Enable AM/PM
[] Enable YEAR
[[] Enable DATE
[] Enable Day Of Week
Enable Second

[] Enable AM PM IN FRONT

Sync. PC GMT Time

oK

Cancel




The font size of the
clock can be setin 4
different sizes.

The digital clock can be
named in the Name box.

-

Preview

Set Clo

Font Size Name Font Color
— |v Portland |
SET
Font 1
mFont 2 Time Sync. By.
Font 3
Font 4
Count LTC 1 v

Figure 111: Set font size

The digital clock
properties can be set as

the following,
1. Clockora
counter

2. canbesyncdto
Internal, LTC or
NTP

3. Daylight savings
on/off

4. Time zone, if the
clock is set to
Internal

5. When the clock is
set to Internal, it
can be sync'd to
the PC’s clock by
clicking on
<Sync. PC GMT
Time>

Made Time Sync. By.
@ Clock
) Counter Internal -
None
. Internal
Time Zone LTC 1
[] Daylight saving TP

|[GMT-DE:DD) Pacific Time (US & Canada)

|v|

Figure 112: Set sync

Sync. PC GMT Time

Figure 113: Sync to PC




The font color and
background color of the
clock can be set by click
on <SET> under the
attributes

Font Color Background Col...

ser [ser ]

Figure 114 set font and background color

Set font color to White,
click <OK> and set
background color to
black, then click <OK>

Choose Font Color

Choose Background Color
Swatches | HSV | HSL | RGB | CMYK

T T T T T
5 e

O B W Sl Tex sampe Tex .
o sampie Ten

D Sample Text Sample Text

Figure 115: Set font color Figure 116: Set background color

Several clock display
options can be set

Option

[] Enable AM/PM

[] Enable YEAR

[] Enable DATE

[] Enable Day Of Week
Enable Secand

[]Enable AM PM IN FRONT

Figure 117: Set Time Format

To insert an analog
clock by dragging the
<Analog Clock> to the
work space

rrrrr

o € pcote Q 2omin

Figure 118: Drag analog clock from object bin to workspace

To set the properties on
the analog clock. Right
click on the clock and
select <Properties>

-

Properties




L] L] Set Analog Clock Properties

o
Hour-Hand set.
]
Color Set
Minute-Hand set
|
Color Set
Second-Hand set
|
Time Sync. By.
Sync. PC GMT Time
s3] [Lamecamme |
Time Zone Time Offset
(GMT-08:00) Pacific Time (US ... | v GMP+ [-28800 | Seconds

Figure 119: Set clock properties

The analog clock
properties can be set as
the following,
1. Canbesync'dto
Internal, LTC or
NTP
2. Daylight savings
on/off
3. Time zone, if the
clock is set to
Internal
When the clock is set to
Internal, it can be sync'd
to the PC’s clock by
clicking on <Sync. PC
GMT Time>

Time Sync. By.

y! Y. Time Sync. By.
e[~ rena [~
Internal

TlLTC 1 i
TP Time Zone

[] Daylight saving

|[GMT-{JB:{]{J) Pacific Time (US ... |v|

|[GMT~08:{J{J) Pacific Time (US ... |v|

Figure 120: Set sync

Sync. PC GMT Time

Figure 1217: Sync to PC time




Clock faces

There are 3 different
type of clock faces
(skins) you can choose
from. The clock hands
and color can also be
configured

Set Analog Clock Properties

Skin Type 1

eCe

Preview

Length: [8s0 ||

Figure 122: Select clock face type 1

[ JoN ] Set Analog Clock Properties
Preview Skin Type 2 -
Skin Type 1
|Skin Type 2

Color Set

!

Minute-Hand set

Length:

Color Set

Second-Hand set

|
Color Set
[ JoN ] Set Analog Clock Properties
Skin Type 3 |v
Skin Type 1
Skin Type 2
Color Set
Minute-Hand set
|
Length: n
Color Set
Second-Hand set
|
Color Set

Figure 124: Type 2

To adjust the GMT time.
Right click on the clock
and select <Control>

Control

‘ene®

Adjust GMT Time

Apply | ‘Svnc.PCGMTT\me

Properties
Control...

Close

Close

Figure 125: Set clock control




Adding standalone
audio meters by
dragging the <Audio Bar
Group> to the work
space.

Right click on the
meters to set the
properties

‘esne
Fle System

Apantac [Director v2.0
Status Help

Frame / Overview | Output: 1

) ) vpane

Toals

Q zemnn

Figure 126: Drag in standalone audio meters

[ ) Meter Bars Configuration

Tot! Meters

Meter 1: SDI: 1, Group: 1, Ch: 1
Meter 2: SDI: 1, Gro
Meter 3: SDI: 1,

o
C I T

Source Alarm Range Meter Width
. Grouf

|SDE: 1, Group: 1, Ch: 1 [~

g 1
Properties... ﬂ I
Audio Meter Bar Space... [sor 1, Gowp: 1, o 182 [
Close WALl Apply to system
Figure 127: Set Audio meter properties
Audio sources can be T
|SDI: 1, Group: 1, Ch: 182 |v|

assigned to each of the
meters.

Any pair of the audio
meters can also be sent
to the audio monitoring
output by clicking on
<Monitor>

Audio alarm range and
audio meter width can
also be set here

|SDI: 1, Group: 1, Ch: 1 |v|

Alarm Range

Meter Width

OK

Apply to system

CANCEL

Figure 128: Set source, Alarm range and Meter Width




Adding a logo to the
layout by dragging the
Picture LOGO to the
work space. Let go of
the mouse and the
dialog box will open for
you to choose the logo
file

ece Apantac iDirector v2.0
File System Status Help

Frame / Overview | Output: 1 | Output:2 |
Tools

) € upase Q zoomin

Figure 129: Drag in logo

[ JON | Load Picture File...

Look In: |ﬁ Documents |" E

D AGR1513166_Page_4.jpg
D AGR1513166_Page_5.jpg
[y AJA FS1 10.jpg

[} apantac logo Vertical 2.jpg

D Apantac logo.gif
D Apantac logo.jpg

1] [i] [»
File Name: |apa.ntac logo Vertical 2.jpg |
Files of Type: |In1ages |v |
Open | | Cancel |
Figure 130: Select a stored logo
Insert a temperature L T — A"
warning by dragging 0' — —

<Temperature> to the
workspace.

Figure 130: Drag in a temperature sensor




Set Temperature alarm ece
roperty by right clickin o e
PrOpETy BY T J e
on the temperature
Alarm High Set
Font Color Background Col...
alarm High: |50 C _
| SET | | SET ‘
Name: [TP High |
Alarm Low Set
Font Color Background Col...
Low: [0 C llllllll.
B [ st ]
Name: [TP Low |
Set Properties...
Case
Figure 131: Right click on the temperature sensor to configure the settings

7.0 Saving Default Layout

The Default Layout is the layout loaded by the Multiviewer during the power on sequence.
This layout is similar to a Saved Preset file but is treated differently by the Multiviewer, as
it will not be visibile under the Preset Load dialog. A common practice is to create the
desired layout save it as a preset for future use and then performing the Quit and Save
function by exting the jDirector software. This Quit and Save is what gerenates the
Default Layout or sometimes refered to as the Last Layout or Latest Layout.

After creating your desired layout or Loading a previously saved Preset file it is
recommended that you first Update all outputs so all changes are reflected on your
Outputs and then select File>Exit.

i Apantac jDirector v2.0
pemee TrEeerY This will prompt you with the Exit Confirmation dialog box.

Fe| ;Es::am S Complete the save by selecting the checkbox for Save
Restore presets to frame ... configurations to flash and then click the Quit and save
Write to flash... button.

) ext
4 Exit Confirmation (=)

Save configurations to flash

Quit and save ‘ ‘ Quit without save

‘ CANCEL

The Default Layout is updated each time a Quit and Save is completed.




8.0 Offline Mode

The jDirector software can also work in offline mode.

Start with a fresh copy of
jDirector and select offline mode

) Connect To Mi-16x...

3 Local Area Network

il

- 7
© |[Online ‘v

Online
(Offline

Figure 132: Select offline mode

It will prompt you to copy your
online folder to the offline folder.
If you would like to continue to
make edits to your online layout,
then click <Yes>, otherwise, click
<No>

O Online >> Offline

? Copy online configure files to offline?

Figure 133: Copy configurations to offline folder

Add a Mi-16 to the editor. You
can choose from the list.

Once you enter the offline mode,
you can start editing as if you
were online.

L ] Connect To Mi-16x.

L2 vocal aves Network
Mi-16% [P Address Manager... |

View log.

® [offine |~
o ° Add Mi-16x
Mi-16+ (PLUS) |~
[e=] [ELS -
Mi-16+ (PLUS) |
Mi-16# (SHARP)
0K Cancel

Figure 134: Select a Mi-16 model for offline editing




Appendix
Mi-16 presets

The Mi-16 can store up to 30 presets. It comes with 10 pre-configured layouts as below,

W Sbis Vs =R Vs

window 1 window 2 window 3 window 4
input no: 1 input no: 2 input no: 3 input no: 4
Input{ 1) Input (2] Input { 3) Input {4}

Vs Viindibis Vi LR
window 5 window & window 7 window 8
input no: 5 input no: & input no: 7 input no: 8

Input {3) Input (6] Input{ 7) Input (8]

VS Vs [LTER Viacdihs

window 9 window 10 window 11 window 12
input no: 9 input no: 10 input no: 11 input no: 12
Input [ 9) Input ( 10) Input [ 11 Input [ 12

VS Vs [LTER Viacdihs

window 13 window 14 window 13 window 16
input no: 13 input no: 14 input no: 15 input no: 16
Input 13) Input ([ 14) Input [ 15) Input ( 16)

Figure 135: Preset1 — 16 windows (Preset1.0Px)

window 1 window 2 window 3
input no: 1 input no: 2 input mo: 3
Input (1) Input [ 2] Input [ 3)

window 4
input no: 4
Input [ 4]

window 5 window & window 7
input no: 5 input no: 6 input no: 7
Input (5] Input (6]} Input [ 7)

window &

input no: 8
Input { 3]

window 9 window 10 window 11
input no: 9 input no: 10 input mo: 11
Input[9) Input ( 10 Input (11}

window 12
input no: 12
Input [ 12

window 13 window 14 window 15
input no: 13 input no: 14 input mo: 15
Input [ 13} Input ( 14 Input ( 15)

window 16
input no: 16
Input [ 16

Figure 136: Preset2 — 16 windows with 2 Tally LEDs (Preset2.0Px)



window 1
input no: 1
Input (1]

window 5
input no: 3
Input (5]

window 9
input no: 9
Input (9]

window 13
input no: 13
Input ( 13)

window 2
input no: 2
Input (2]

window &
input no: &
Input (6]

window 10
input no: 10
Input [ 10)

window 14
input no: 14
Input [ 14

window 3
input no: 3
Input (3]

window 7
input no: 7
Input [ 7]

window 11
input no: 11
Input {11}

window 15
input no: 15
Input ( 15)

Figure 137: Preset3 — 16 windows with 2 audio

window 4
input no: 4
Input{ 4]

window 8
input no: 8
Input [ 8]

window 12
input no: 12
Input( 12)

Input(12 )

window 16
input no: 16
Input( 16)

Input (16 )

window 1
input no: 1
Input(1)

window 5
input no: 5
Input (5]

window 9
input no: 9
Input (9]

window 13
input no: 13
Input ([ 13)

1T

window 2
input no: 2
Input {2}

window 6
input no: 6
Input (6]

window 10
input no: 10
Input ([ 10)

window 14
input no: 14
Input ([ 14)

window 3
input no: 3
Input [ 3)

window 7
input no: 7
Input [ 7)

window 11
input no: 11
Input (11

window 15
input no: 15
Input ([ 15)

window 4
input no: 4
Input(4)

window 8
input no: 8
Input [ 8)

window 12
input no: 12
Input ([ 12]

Tnput( 12 )

window 16
input no: 16
Input ([ 16)

Tnput( 16 )

Figure 138: Preset4 — 16 windows with 2 Tally LEDs and 2 Audio Meters (Preset4.0Px)

windowr 1
input no: 1
Input(1)

Input( 1)

window &
input no: &6
Input( 6]}

Input(s )

window 11
input no: 11
Input [ 11]

window 2
input no: 2
Input (2]

Input(2)

window 7
input no: 7
Input [ 7]

Input(7)

window 3
input no: 3
Input (3]

Input( 3)

window 8
input no: 8
Input (8]

Input(8)

window 12
input no: 12
Input [ 12]

windowr 4
input no: 4
Input 4]

Input(4 )

window 9
input no: 9
Input (9]

Input(9)

Figure 139: Preset5 - 14 windows (Preset5.0Px)

window 5
input no: 5
Input [ 5)

Input( &)

window 10
input no: 10
Input [ 10)

Input(10)

window 13
input no: 13
Input ( 13)

window 14
input no: 14
Input [ 14)




not assigned et assigned net assigned not assigned et assigned

not assigned net assigned not assigned net assikaned

not assigned

Figure 140: Preset6 — 14 windows with 2 audio meters (Preset6.0Px)

window 1 window 2 window 3 window 4
input no: 1 input no: 2 input no: 3 input no: 4
Input (1) Input [ 2] Input (3] Input (4]

Input( 1} Input( 2} Input(3) Input( 4}

window 5 window 6 window 7 window 8
input no: 5 input no: & input no: 7 input no: 8
Input {5} Input (6] Input [ 7) Input ( 8)

Input (5 ) Input (&) Input (73 Input(8)

window 9 window 10 window 11 window 12
input no: 9 input no: 10 input no: 11 input no: 12
Input (9] Input [ 10]) Input [ 11] Input [ 12]

Input(s ) Input (10} Input( 11} Input (12}

window 13 window 14 window 15 window 16
input no: 13 input no: 14 input no: 15 input no: 16
Input( 13) Input [ 14]) Input [ 15) Input ( 16)

Input (13 ) Input (14 ) Input (15 ) Input (16 )

Figure 141: Preset7 — 16 windows with labels inside the windows (Preset7.0Px)



window 1 window 2 window 3
input no: 1 input no: 2 input no: 3
Input (1) Input (2] Input (3]

Input(1) Input( 2} Input( 3 )

window 5 window & window 7
input no: 5 input no: & input no: 7
Input [ 5) Input (6] Input (7]

Input(5) Input {6 ) Input {7 )

window 3 window 10
input no: 9 input no: 10
Input (9] Input [ 10)

Input(s ) Input( 10}

window 4
input no: 4
Input (4]

Input(4)

window §
input no: 8
Input(8)

Input(8)

window 11
input no: 11
Input [ 11)

Input( 11}

Figure 142: Preset8 — 11 windows with 2 audio meters (Preset8.0Px)

window 1 window 2
input no: 1 input no: 2
Input( 1) Input (2]

Input(1} Inputl 2}

window 3 window 5
input no: 4 input no: 5
Input (4] Input (5]

Inputi 4} Input( 5}

window 7 window 8
input no: 7 input no: 8
Input( 7] Input (8]

window 3
input no: 3
Input [ 3]

Input( 3}

window 6
input no: &
Input (&)

Input(6 )

window 9
input no: 9
Input (9]

Figure 143: Preset9 — 9 windows with 2 audio meters and labels inside (Preset9.0Px)

Inputi 7} Input( 8} Input(s}

i |

window 1 II II window 2 window 3
input no: 1 input no: 2 input no: 3
Input{ 1] Input [ 2] Input [ 3]

window 5
input no: 5
Input (5]

window 11
input no: 11
window 7

input no: 7
Input{ 7]

input no: 9
Input (9]

b Mi-16

Input (11) “ "

input no: 4
Input (4]

window &
input no: 6
Input (G)

window &
input no: 8
Input (8]

I“put ( 11 ) “ window 9 “ " window 10

input no: 10
Input ( 10)

Figure 144: Preset10 — 11 windows with 2 audio meters and labels inside (Preset9.0Px)




Mi-16+ presets

The Mi-16+ can store up to 30 presets. It comes with 10 pre-configured layouts as below:

dow 2 dow 3 dow 4 dow window 2 window 2 dow 4
input no: 2 input no: 3 input not 4 input not 9 input not 10 input no: 11 input not 12

Input (11) Input ( 12)

Tnput (2) Tnput (3) TInput (4 nput (93 Input ( 10)

window 5 dow & dow 7 dow & dow 5 dow &
input no: 5 input no: & input no: 7 input not & input no: 13 i : input no: 15 input mo: 16
Input (3} Input (6) Input (7) Tnput (8) Tnput (13) Input ( 15) Tnput ( 16)

Figure 145: Preset1 — 8 windows on each output with Analog, digital clocks and Standalone Labels (Preset1.0Px)

window 1 swindou 2 swindow 3 window 1 window 2 window 3
input mo: 1 input no: 2 input no: 3 input mo: 3 input mo: 10 input mo: 11
Tnput (1) Input ( 2) Input ( 3) Tnput ( 5) Tnput ( 10) Tnput (1)

Inpuc(1) Inpuc(2) Input(3) Input( &) Input(10) Input(11)

window 4 window 5 window & window 4 window 5 window 6
input nos 4 input no: 5 input no: & input no: 12 input no: 13 input nos 14
TInput (4 Input (5) Input (6) Input ( 12) Input ( 13) Input ( 14)

Input(4) Input(5) Input () Input (12 Input(13) Input (14 )

window 7 window 8 window 7 window 8
input no: 7 input no: 8 input no: 15 input no: 16
Input(7) Input(8) Input ( 15 ) Input ( 16 )

Tnput (7) Tnput (8) Input(15) Input(16)

Figure 146: Preset? — 8 windows on each output, labels inside the windows (Preset2.0Px)

window 1 window 2 window 3 window 4 windows 1 wrindow 2 window 3 window 4
input no: 1 input ne: 2 input no: 3 input no: 4 input no: 9 input no: 10 input no: 11 input no: 12
Input (1) Input (2) Input (3) Input (4) Input (9) Input (10) Input (11) Input (12)

Trput(1) Thput(2) Thpt( 3] Thpt(4) TApLE (10) TPt (1) TPt (12)

window 5 window 6 window 7
input no: 5 input no: 6 input no: 7
Input (5) Input (6) Input ( 7)
window 3 window &
input no: 13 input no: 14
Input (13} Input (14

Input (13) Input (14 )

window 1 window 2 window 3 window 4
input mo: 1 input no: 2 input no: 3 input no: 4
nput (1) nput (2) Input (3) nput (4)

window 5 window 6
input no: 5 input no: &
Input (5) Input (6)
window &
input no: 13 input no: 1%

windowr 8 Tnput ( 12) Tnput ( 14)

input no: &
Input (8)

Input (13 ) Input (14 )

Figure 148: Preset4 — (Preset4.0Px)



window 1 window 2 window 3 window 4 window 1 window 2 swindowe 3 window 4
input no: 1 input na: 2 input no: 3 input no: 4 input no: 3 input ne: 10 input no: 11 input no: 12
Tnput (1) Tnput ( 2) Tnput ( 3) Input (4) Input (9) Input ( 10) Tnput (11) Input ( 12)

window 5 i windor 7 window 5 window 6 window 7
input no: 5 : input na: 7 input no: 13 input no: 14 input no: 15
Input (5) Input (6) Input (7) Input ( 13) Input ( 14) Input ( 15)

Input (13) Input(14) Input (15)

Figure 149: Preset5 - 15 windows (Preset5.0Px)

windowr 1 windour 2 windour 3 windour 4 windows 1 windows 2 windowr 3 windowr 4
input no: 1 input no: 2 input no: 3 input ne: 4 input no: 9 input no: 10 input no: 11 input no: 12
Input (1) Input (2) Input (3) Input (4) Input (9) Input ( 10) Tnput ( 11) Input ( 12)

Input (&) Input (10 ) Input(11) Input (12 )

window 7 window 7
input no: 7 input no: 15
Tnput (7) Input  15)

window 8 window 8
input no: 8 input no: 16
Input (8) Input (16)

windour 5 windour 6 windowr 5 window 6
s 3 input no: 13 input no: 14
Tnput ( 13) Tnput ( 14)

Input (16 )
Tnput (5) Thput (6) Tnput (13) Tnput (14)

Figure 150: Preset6 — 16 windows (Preset6.0Px)

window 1 window 2 window 3 svindow 1 window 2 window 3
input no: 1 input no: 2 input no: 3 input no: 9 input no: 10 input no: 11
Tnput (1) Input (2) Tnput (3) Input (9) Tnpat ( 10) Tnput (11)

window 4 window 5 window 6
input no: 4 input no: 5 input no: & input no 12 input no: 13 input no: 14
Tnput (4) Input (5) Tnput (6) Input ( 12) Tnput (13} Tnput ( 14)

window 7 window 8 window window 8
input mo: 7 input no: 3 input not 15 inputno: 16
Input (7) Tnput ( 8) Input ( 15) Tnput ( 16)

window 1 window 2 window 3

input nos 1 input no: 2 input no: 3

Input (1) Input (2) Input (3)
window 1 window 2
input no: 9 input no: 10
Tnput (9) Input (10)

Input(1) Inpue(2)

window 4 window 5 window &

input no: 6 Inpue(9) Input (10)

input ne: 4 input no: 3
Tnput (43 Tnput (3 Input(6)

Inpur(4) Inpue(5) Tnput(6)

window 4
input no: 11 input no: 12
Tnput ( 11} Input ( 12)

window 7 window &

input no: 7 inputno: 8

Tnput (7) Tnput (8)

Input(7) Input(8) Input(11) Input (12)

Figure 152: Preset8 — 12 windows with 2 audio meters (Preset8.0Px)



window 1
input no: 1
Input(1)

window 4
input no: 4
Input (4)

windove &
input no: 6
Input (&)

window 5
input no: 5
Input (5)

windowe 7
input no: 7
Input (7)

windowe 2
input not 2
Input(2)

window &
input no: &
Input (8)

window 3
input not 3
Input (3)

window 1
input no: 9
Input (3}

dow &
input no: 16
Input  16)

window =
input no: 10
Input ( 10)

Trpu(10)

window 4
input ne: 12
Input ( 12)

window 3
input no: 11
Input(11)

input no: 13
Input ( 13)

Mi-16+ OQutput 1

Figure 153: Preset9 — 9 windows with 2 audio meters and labels inside (Preset9.0Px)

| Mi-16+Output2 |

window 1
input no: 1
Input (1)

TopLt (1)

window 5

input no: 5
Input (5)

Trput(

window 2
input no: 2
Input (2)

Thput (2]

window &

input no: €
Input (6)

window 3
input no: 3
Input ()

window 7
input no: 7
Input (7)

window 4
input no: 4
Input  4)

TApuE(4)

window &

input no: 8
Input (8)

Thpuc(8)

Figure 154: Preset10 — 16 windows with 2 audio meters (Preset10.0Px)

Mi-16# presets

windovr 1
input no: 1
Input(1)

window 5
input no: 5
Tnput (5)

window 3
input no: 3
Input (3}

window 2
input no: 7
Input (2)

window &
input no: &
Input (6)

window 10
input no: 10
Input ( 10)

window 2
input no: 3
Input(3)

swindovs 7
input no: 7
Input (7}

window 11
input no: 11
Input (11)

window 4
input no: &
Input (4)

window 8
input no: &
Input (&)

window 12
input no: 12
Input ( 12)

input no: 9
Input (9)

TRECS]

window 2
input no: 10
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windour &

input no: 14
Tnput ( 14}

window 3
input no: 11
Input ( 11)

ThpLt (13

window 7

input no: 15
Tnput ( 15)

window 4
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windove &

input no: 16
Tnput (16)

ThpuE( 16

dow 3
input no: 13
Tnput ( 13)

window 1
input no: 15
Input ( 15)

Input ( 14 )
| Base Configuration |

dow 2
input no: 16
Input ( 16)

Input (16)

Figure 155: Preset1 — (Preset01.0PX)
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Input (4)
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window 7
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Input ( 7)
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Figure 156:
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input no: 2
Input (2)
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input no: 5
Input (5)
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Input (8)
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Preset2 — (Preset02.0PX)

window 3
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window 9
input no: 9
Input (3)
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Input (13}

window & window 5
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Input (14}
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Tnput (1)

TApLE(1)

Tnput (5)

Tnput (&)

window 2

input
Input (2)

window 7
input no: 7
Tnput (7)

window 3
input no: 3
Tnput (3}

window 4
input no: 4
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window 8
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Input (8)

window 1
input no: 9
Tnput ()
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window 8
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Input ( 16
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Figure 157: Preset3 — (Preset3.0PX)
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Figure 158: Preset4 — (Preset4.0PX)
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Figure 161: Preset7 — (Preset7.0PX)
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Figure 163: Preset9 — (Preset9.0PX)
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Figure 164: Preset10 — (Preset10.0PX)
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Cable Pinouts
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Copyright & Trademark

Copyright © 2010 Apantac LLC. All rights reserved by APANTAC LCC, Beaverton, Oregon, USA. No part of this
document may be reproduced in any form or by any means without written permission from the product manufacturer.
Changes are periodically made to the information in this document. They will be incorporated in subsequent editions.
The product manufacturer may make improvements and /or changes in the product described in this document at any
time.

Apantac, Tahoma, MT Hood and Crescent are registerd trademarks of Apantac LLC. All other trademarks are the
property of their respective holders.

Warranty Statement

Apantac LLC (herein after referred to as “Apantac”) warrants to the original purchaser of the products
manufactured by Apantac (the “Product,”) will be free from defects in material and workmanship for a
period of three (3) year from the date of shipment of the Product to the purchaser.
If the Product proves to be defective during the three (3) year warranty period, the purchaser’s exclusive
remedy and Apantac’s sole obligation under this warranty is expressly limited, at Apantac’s sole option, to:
(a) repair the defective Product without charge for parts and labor or,
(b) provide a replacement in exchange for the defective Product or,
(c) if after areasonable time, is unable to correct the defect or provide a replacement Product in good
working order, then the purchaser shall be entitled to recover damages subject to the limitation of
liability set forth below.

Comformity

Apantac products has been tested and found to comply with the following,
FCC-Class A part 15

CE/C-tick

California Propersition 65

REACH SVHC

EU RoHS 10 Substances Amendment

Limitation of Liability

Apantac’s liability under this warranty shall not exceed the purchase price paid for the defective product. In no event
shall Apantac be liable for any incidental, special or consequential damages, including without limitation, loss of profits
for any breach of this warranty.

If Apantac replaces the defective Product with a replacement Product as provided under the terms of this Warranty, in
no event will the term of the warranty on the replacement Product exceed the number of months remaining on the
warranty covering the defective Product.

Equipment manufactured by other suppliers and supplied by Apantac carries the respective manufacturer's warranty.
Apantac assumes no warranty responsibility either expressed or implied for equipment manufactured by others and
supplied by Apantac.

This hardware warranty shall not apply to any defect, failure or damage:
a) Caused by improper use of the Product or inadequate maintenance and care of the Product;
b) Resulting from attempts by those other than Apantac representatives to install, repair, or service the Product;
¢) Caused by installation of the Product in a hostile operating environment or connection of the Product to
incompatible equipment;



Contact Apantac Technical Support

For technical inquiries including product and system issues, hardware and software information

and more.

Technical Support Hours:
Monday - Friday
7:00 AM to 5:00 PM (PT)

Technical Support Assistance:
Phone: +1 (503) 968-3000
Email: support@Apantac.com
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